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КІРІСПЕ
Адамзат өркениетінің даму қарқынының негізгі сипатының бірі қазіргі уақытта индустриалдықтан информациялық қоғамға, неосферадан инфосфераға өтуі болып отыр. Жаппай компьютерлендіру жаңа информациялық технологияларды оқыту саласында бизнесте, өндірісте, ғылыми зерттеуде және әлеуметтік өмірде кеңінен қолданудың, дамудың жаңа деңгейін жасайды. 70 жылдардың басында компьютерлік бөлшектер шығару саласында үлкен техникалық жаңалық ашылды, үлкен интегралдық үлгілер пайда болды. 80 жылдардың ортасында жергілікті және ауқымды желілер дами бастады. Компьютерлік желілерде Web-сайттарды құруда көптеген дизайндар жасалады соның ішінде дыбыстар, анимациялар, видео роликтер кірістіріледі. 

Бүгінгі таңда технологияның қарқынды дамуына байланысты компьютерлердің графикалық мүмкіндіктері күннен-күнге үлкеюде. Қазіргі компьютерлердің мүмкіндігіне байланысты программалар да аз жасалып жатқан жоқ. Соның ішінде, анимация жасауда көп қолданысқа ие Macromedia Flash программасы. Бұл программаны көбінесе Web-сайттарды құруда  көп қолданады. Соңғы кезде электронды оқыту өнімдері нарығында, Macromedia Flash технологиясы негізінде жасалған және тәжірибесі жоқ компьютер қолданушысына программалық өнімдер жасау мүмкіндігін беретін оқу құралдары мен мультимедиялық оқулықтар саны көбейіп барады. Қазір Macromedia Flash-технологиясы ең жаңа және кең қолданылып жатқан технология болып табылады. Macromedia Flash технологиясы анимация жасаушылар үшін өте қолайлы программа, өйткені ол  төмендегі сапаларға ие:

1. Жинақтылық (компьютерде тез жүктеледі) – векторлық графиканы пайдалану есебінде;

2. Интерактивтілік – пайдаланушы Flash-фильмдегі іс әрекеттерді тікелей басқара алады;

3. Мультимедиялық – фильм және Internet-ке информацияны визуалдаудың стандартты құралдары үшін қол жетпес видео, аудио эффектілер;

4. Көпсалалығы – Macromedia Flash-те қарапайым үй парақтары сияқты арнаулы серверлер де (пошталық, виртуальді дүкендер) орындалуы мүмкін;

5. Қолайлылық – Macromedia Flash технологиясының негізі, компьютермен жұмыс істеудің минимальді дағдысы бар кез-келген адамға түсінікті. Сондай-ақ компьютер жадында өте аз орын алуы мен тез жүктелетіндігі Macromedia Flash пайдаланушылары үшін үлкен мүмкіндіктер туғызады.

Осы мақсатымызға жету үшін, бізге Macromedia Flash технологиясын білу өте маңызды рөль атқарады.
Жұмыстың мақсаты: Macromedia Flash  технологиясын желі арқылы оқыту мүмкіндіктерін меңгеру.

Зерттеу нысаны: Macromedia Flash  технологиясын оқытатын электрондық оқулық жасалынды.

Жұмыстың құрылымы: Кіріспе, 2-тарау, қорытынды және қолданылған әдибеттер тізімінен тұрады. 
I-тарау. Компьютерлік желілер және онда графикалық ақпараттарды тасымалдау
1.1. Желілер және оның түрлері

Компьютерлік желі – байланыс сызығы арқылы ақпарат алмасушы бір немесе бірнеше компьютерлер жиынтығы. Компьютерлік желі ақпаратты бір компьютерден екінші компьютерге өткізуге, сонымен қатар төмендегі ресурстарды: принтерлер, модемдер және хабарларды сақтау құрылғыларын пайдалануға мүмкіндік береді. Үлкен желіні – ресурстарға мүмкіндік ашу деңгейін, пароль қою мүмкіндігін, пайдаланушы құқығын беретін желілік администратор басқарады.

Желілер:

●Локальды (аймақтық) желі – бір-біріне жақын орналасқан компьютерлерді басқарады. Мысалы, бір ғимаратта орналасқан көрші бөлмедегі компьютерлер.

●Глобальды (ауқымды) желілер – глобальды желілер ережеге сай бірнеше локальды желілерді біріктіреді. Компьютерлер әр түрлі қалаларда және әр түрлі елдерде болуы мүмкін.
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1-сурет.Желілер түрлері.

Жергілікті желі (LАN) бір ғимарат ішіндегі немесе қатар орналасқан ғимараттардағы дербес компьютерлер мен принтерлерді бір-бірімен байланыстырады. Аймақтық-таратылған желілер (WАN) географиялық тұрғыдан алатын бір-бірінен қашықта орналасқан бірақ бір компанияға немесе фирмаға, мекемеге қатысты бірнеше жергілікті желілерді байланыстырады.
Жергілікті желілер - дербес компьютерлерді бір-бірімен немесе оларды желі сервері рөлін атқаратын қуатты компьютермен байланыстырып тұратын желінің ең қарапайым түрі.
Жергілікті желінің барлық компьютерлері серверде жазылған қолданбалы программаларды және принтер, факс тәрізді шеткері құрылғыларды ортақ пайдалана алады. Желідегі әрбір дербес компьютер жұмыс станциясы немесе желі түйіні деп аталады.
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2-сурет. Жергілікті желілер.

Жергілікті жері әрбір тұтынушыға бір-бірімен өте жылдам
қатынасуға мүмкіндік жасайды. Оның мынадай ерекшеліктерін атап
өтуге болады:
 
- құжаттарды бірге пайдалану;
- құжат айналымын жеңілдету;

тұтынушы жұмыс орнынан тұрмай-ақ, жиналыс жасамай-ақ әртүрлі құжаттарды оқуға, түзетуге, түсініктеме беруге мүмкіндік алады;
- компьютер дискісіндегі орынды тиімді пайдаланып, өз жұмыс нәтижелерін серверде сақтау және архивтеу;

- сервердегі қолданбалы программалармен оңай байланысу;
- қымбат тұратын қорларды 
 принтерлерді, СD-RОМ мәлімет жинақтауыштарын, қатты дискілерді және ортақ пайдалануға болатын көлемді қолданбалы программаларды (мысалы, мәтіндік процессорларды немесе мәліметтер базасын) бірігіп пайдалануды жеңілдету, т.б.
Аймактық-таратылған желілер жергілікті желілер жасай алатын барлық жұмыстарды өте қашықта орналасқан бір компания компьютерлері арасында атқара алады. Әдетте ол үшін модем немесе жоғары жылдамдықты цифрлы желі арналарын ортақ пайдалануға арналған кешендік қызмет (ISDN, Integrated Services Digital Netwoek) көрсете алатын байланыстық телефон арналары қолданылады. Мұнда ISDN арналары графикалық бейнелер жазылған үлкен көлемді файлдары тасымалдау үшін жиі қолданылады.
Модем- бұл компьютерлерге телефон желілері немесе басқа да байланыс тораптары арқылы мәліметтер алмасуға мүмкіндік беретін құрлығы.
Модемдер жай телефон арналары арқылы Интернетке қосылып, онымен мәлімет алмасу мүмкіндігін береді. "Модем" деген сөз осы құрылғының қызметіне байланысты шыққан, ол "модулятор/ демодулятор" сөздерінің қысқаша түрі. Модем дербес компьютерден шыққан цифрлық сигналдарды жалпы телефон арналары арқылы тасымалданатын аналогтық сигналдарға түрлендіреді. Ал екінші модем қабылданған сигналдарды қайтадан цифрлық формаға ауыстырады. 
Модем арқылы қосылым жасау үшін компьютердің иесі лайықты провайдер тауып, онымен Интернет-те жұмыс істеу шарттары туралы келісімге отыруы тиіс. Осыдан кейін ол провайдерден пайдаланушы есімін, құпия сөз және өз компьютерін өз телефон консолі арқылы Интернет- ке қоса алатын қашықтағы телефон нөмірін алады. 
Модем немесе алыста орналасқан север көмегімен жүзеге асатын аймақтық тармақталған желілер функциясын жергілікті желілер құрамына енгізе отырып, сыртқы коммуникация технологияларынын төмендегідей мүмкіндіктерін пайдалануға болады:
- электрондық пошта арқылы мәліметтерді қабылдау және жөнелту;
- Интернетпен байланысу.
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3-сурет. Модемдер арқылы байланыс жасауы.

Интернет дегеніміз - дүниенің әр түкпіріндегі тұтынушыларды бір-бірімен мәліметтер қоймасы, бейнелер және дыбыстар жазбалары арқылы жеңіл байланыстыратын ең ауқымды желі түрі. Өз көлемін жылдам ұлғайта отырып (шамамен жылына 200%), ол біздің өмірімізде күнен күнге өте елеулі рөл атқарып келеді.
Қазіргі кезде Интернеттің ең негізгі функцияларына электрондық пошта қызметі мен мамандықтары бір немесе ортақ мәселемен айналысатын топтардың немесе зертеушілердің бір-бірімен жылдам мәлімет алмасуы жатады.
Интернет күнен-күнге қуатты екпін алып, оған көптеген компаниялар мен фирмалар және қарапайым тұтынушылар үздіксіз қосылуда. Компаниялар мен олардың жабдықтаушылары және тұтынушылары арасындағы байланыс дәнекері рөлін атқаратын осы Интернет желісі болып табылады. Қазіргі кезде мекемелер және әрбір жеке отбасы үшін атқарылатын алыстан оқыту жүйелері, алыстан кеңес беру, емдеу жұмыстары тәрізді мәліметті, сөзді, бейнені, қозғалысты қашықтан жылдам жеткізу жұмыстары осы Интернет арқылы жүзеге асырылады.

    Қашықтан оқыту- оқулық материалды жеткізу, оны өз бетімен оқып үйрену, оқыту үрдісі қандай да бір нақты оқу орнының орналасқан жеріне тәуелсіз болған жағдайд оқытушы мен оқушылар арасындағы сұхбатты ұйымдастыру үшін қолданылатын дәстүрлі және жаңа ақпараттық-коммуникациялық технологияларды пайдалануға негізделген оқытудың интеграциялық нысаны.

    Қазақстанда ҚО жүйесін халықтың мынадай категориялары қажет етеді: ЖОО студенттері; орта мектептер оқушылары(әсіресе ауылдық жерлерде, шағын қалалар мен ауылдарда); турлі деңгей басқарушылары; аймақтық басқару органдары жетекшілері; жұмыспен қамту қызметінде тіркелген тұлғалар; қандай да бір білім саласындағы біліктілігін арттырғысы келетін тұлғалар; қозғалыс еркіндігі шектеулі адамдар, мүгедектер және т.б.

     Қашықтан оқыту негізгі ақпараттық-коммуникациялық технологиялары;

    ●оқу-әдістемелік материалдар жинақтарын құрамдастырып, оқушыларға өз бетімен оқып-үйрену үшін таратуға негізделген кейс-технологиялар;

   ●  эфирлік, кабелді және ғарыштық телевизия жүйелерін пайдалануға негізделген ТВ- технологиялар;

  ● студенттерді оқу-әдістемелік материалмен қамтамасыз ету үшін де, оқытушы мен оқушы арасындағы интерактивті қарым-қатынас орнату үшін де Internet желісін пайдалануға негізделген желілік технологиялар;

    Internet арқылы қашықтан оқыту жүйесін Internet желісіне қатынай алатын кез келген адам пайдалана алады.

Кез келген компьютерлік желі жұмысы топология, хаттама (протокол), интерфейс, желілік-программалық және техникалық құралдар тәрізді сипаттамалармен көрсетіледі.
Желі топологиясы оның негізгі функциональдық элементтерінің бір-бірімен байланысу құрылымын анықтайды. 
Желілік техникалық құралдар - компьютерлерді бір желіге ұйымдастыруды қамтамасыз ететін әртүрлі құрылғылар жиыны.
Желілік программалық кұралдар - компьютерлік желі жұмысын басқарып, әрбір тұтынушыны қажетті интерфейспен қамтамасыз етеді.
Интерфейстер - желінің функциональдық элементтерін бір-бірімен үйлестіру құралдары.
Протоколдар - желінің функциональдық элементтерінің бір-бірімен қатынас жасау ережелері. Функиональдық элементтер ролін әртүрлі құрылғылар және де программалық модульдер атқара алады. Сол себепті ақпараттық және программалық интерфейстер қарастырылады.
Желінің атқаратын қызметіне байланысты топологиялардың үш түрі болуы мүмкін.
Шиналық топология. Мұнда жұмыс станциялары желі адаптерлері арқылы жалпы шинаға немесе магистральға (кабельге) қосылады. Дәл осындай тәсілмен магистральға басқа да желілік құрылғылар қосыла береді. Желінің жұмыс жасау процесінде тасымалданатын ақпарат жөнелтуші станциядан жұмыс станцияларының барлық адаптерлеріне жеткізіледі, бірақ оны тек адресте көрсетілген жұмыс станциясы қабылдайды. 
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4-сурет. Шиналық топология.

Жұлдыз тәрізді топология. Мұнда ортақтандырылған коммутациялық түйін - желілік сервер болуы тиіс, ол барлық мәліметтерді жеткізуді жүзеге асырады . Бұл топологияның артықшылығы - кез-келген бір жұмыс станциясының істен шығуы жалпы байланысқа әсер етпейді.
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                                       5-сурет. Жұлдыз тәрізді топология.

Сақиналық топология. Мұнда байланысу арналары тұйықталған сақина бойында орналасады. Жөнелтілген мәлімет біртіндеп барлық жұмыс станцияларын аралап шығады да, оны керекті компьютер қабылдаған соң жұмыс тоқтатылады. Бұл топологияның кемшілігі -кез-келген бір жұмыс станциясының істен шығуы жалпы байланысты бұзады.

Компьютерлерді желіге біріктіру технологиясының стандарты бекітілді. 

Ол стандарттар: EtherNet, Arcnet, Token Ring. Олардың қарқынды дамуына дербес компьютерлердің дамуы тікелей әсер етті. Бұл құрылғылар бір жағынан программалық жабдықтармен жұмыс істеуде қуатты, екінші жағынан күрделі есептерді шығаруға, сонымен қатарперифериялық құрылғыларды және дискілерді қолдану үшін қуаттылықты біріктіру қажеттілігін туғызады. Бүгін де есептеуіш желілер қарқынды дамуда. Жергілікті және ауқымды желілер арасындағы алшақтық кабельдік жүйедегі жергілікті желілер сапасынан кем түспейтін, жоғары жылдамдықтағы, аумақтық байланыс араларының пайды болуына байланысты барынша азаюда.


Ауқымды желілер ресурс қызметінде локальді желілер қызметіне сәйкес ыңғайлы болуда. Сонымен есептеуіш желілер компьютерлік технологиялар эволюциясының дамуынан шыққан.


Есептеуіш желілер – бұл байланыс желілермен біріктірілген компьютерлер жиыны. Байланыс желілері кабельдерден, желі адаптерлерінен және коммуникациялық құрылғылардан тұрады. Барлық желі құрылғылары жүйенің және қолданбалы программалық жабдықтардың басқаруымен жұмыс істейді.

Желінің негізгі мақсаты желі қолданушысына компьютердің барлық ресурстарын бірігіп қолдану мүмкіндігін беру.

Кез келген компьютерлік желінің негізгі қызметі: желіге қосылған қолданушыға ақпараттық және есептеуіш ресурстарын қолдану қызметін ұсыну.

1.2. Желілік техникалық құралдар

Жергілікті немесе аймақты тармақталған желілер архитектурасына байланысты негізгі компоненттер мен технологиялар мынадай бөлітерден тұрады:

Аппараттық құралдар:
- кабельдер;
- серверлер;
-желілік интерфейс тақшалары (NIC, Network Interface Card);
- концентраторлар;
- коммутаторлар;
- аймақтық тармақталаған желілер үшін бағдарлауыштар (маршуртизаторлар);
- аймақтық тармақталаған желілер үшін қашытқтан қатынас құру
серверлері;

- аймақтық тармақталаған желілер үшін модемдер;
Серверлер. Клиент/сервер желісіндегі сервер дегеніміз осы желіге қосылған басқа компьютерлер пайдалана алатын файлдар мен қолданбалы программаларды сақтауға арналған жоғары көлемді қатты дискісі бар дербес компьютер болып табылады. Бұған қоса серверде желілік операциялық жүйе (NOS, Network Operating System) орнатылып, ол шеткері қүрылғыларды (принтерлер тәрізді) да басқар алады.
Желілік интерфейс тақшалары (NOS, Network Operating System) үстелге қойылатын және портативті алып жүруге ыңғайлы компьютерлерге орнатылады. Олар жергілікті желідегі басқа құрылғылармен қатынас құру үшін қажет. Компьютер жұмыс өнімділігіне бірсыпыра талаптар қоятын әртүрлі дербес компьютерлерге арналған желі тақшаларының көптеген түрлері бар. Олар мәліметтерді тасымалдау жылдамдығынын өзгеруі мен желіге қосылу тәсілдеріне байланысты әртүрлі болып келеді.
Модемдер жай телефон арналары арқылы Интернетке қосылып, онымен мәлімет алмасу мүмкіндігін береді. "Модем" деген сөз осы құрылғының қызметіне байланысты шыққан, ол "модулятор/ демодулятор" сөздерінің қысқаша түрі. Модем дербес компьютерден шыққан цифрлық сигналдарды жалпы телефон арналары арқылы тасымалданатын аналогтық сигналдарға түрлендіреді. Ал екінші модем қабылданған сигналдарды қайтадан цифрлық формаға ауыстырады. 
Желілік программалық құралдар. Жергілікті және аймақтық тармақталған желілер архитектурасына байланысты программалық құралдар:     

-желілік операциялық жүйеден,         
- желіні басқару программалық құралдарынан тұрады.

Желілік операциялық жүйе (NOS, Network Operating System) - желіге қосылған әрбір дербес компьютерде пайдаланылатын программалық кұрал. Ол желілік ресурстарды басқарып, олармен қатынас жасауды қадағалап отырады. Желілік операциялық жүйе тасымалданатын мәліметтерді баратын бағыттары бойынша бағдарлауды (маршруттауды), желілік құрылғылар үшін бәсекелік қайшылықтарды шешуді және дербес компьютердің операциялық жүйесімен, мысалы Windows 95, Windows NT, UNIХ, Масintosh немесе ОS/2 жүйелерімен жұмыс істеуді ұйымдастырады.
Желілік операциялық жүйе файлдар мен қолданбалы программалардың үйлесімді жұмыс жасауын қамтамасыз етеді. Осындай бір жұмыс станциясында орналасқан ресурстар бірге пайдаланыла отырып, керекті мәліметтер алушыларға жөнелтіліп және олар басқа компьютерлерден өзгертіле алады. Желілік операциялық жүйенің негізгі бөлігі серверде орналасады да, қалған бөліктері барлық жұмыс станцияларында қызмет етеді.
Желілік операциялық жүйе қосылған барлық құрылғыларды анықтап, ортақ пайдаланылатын шеткері құрылғыларға жұмыс станцияларының қатынасу приоритетің (егер бірнеше станция қатар сұраныс берсе) айқындап отырады. Бұған қоса операциялық жүйе графикті реттеу ролін атқарып, каталогтармен жұмыс істеуді басқарады және ақпаратты сақтау жүйесін бақылау өкілеттігін жүргізіп, желіні басқару функциясын жүзеге асырады. Кең тараған желілік операциялық жүйелерге Windows NT Server, Novell Netware, Banyan VINES тәрізділер жатады. 

Желіні басқару программалық құралдары желіні қадағалау, басқару және ондағы мәліметтерді сақтау істерінде манызды рол атқарады. Ол желіні тоқтатып қоюға мүмкіндік бергізбейтін және қысылшаң кездерді болдырмайтын, желіні жеке иеленудің (TCO, Notal Cost og Ownership) жалпы құнын төмендететін басқару істерін алдын ала жүргізеді.

Желі администраторлары басқару жұмыс станциясы немесе World Wide Web қызметі арқылы графиктегі заңдылықтарды қадағалай алады, осы сегментті шектен тыс жұмыс атқаруға әкелетін мүмкіндіктерді анықтап береді. Бұған қоса кенеттен туындаған қиғаш мәселелерді тауып олардың әсерлерін азайтады және жұмыс өнімділігін жоғары деңгейге көтеруге мүмкіндік беретін желі құрылымын таңдай алады. Желіні толықтыру және күрделендіру барысында RMON және RMON 2 сияқты қадағалау (мониторинг) жабдықтары администраторларға желі ортасын бақылап отыруға көмектеседі.

Осындай қадағалау жабдықтары желі шекараларынан тиянақты мәліметтерді дер кезінде алып отыруды қамтамасыз етеді және сол арқылы желі администраторы туындайтын қиындықтардың алдын алып отырады.
Программалық құралдар бұған қоса тасымалданатын мәліметтерді кездейсоқ өзгерулерден сақтайды. Желі адмистраторлары басқаруға арналған жұмыс станциясы арқылы пароль орната алады, тұтынушылардың қандай құрылғыларды пайдалана алатынын анықтайды және заңсыз мәлімет алмақшы болғандарды тауып тіркеп отырады.
1.3. Клиент-сервер технологиясы

Жергілікті желілердегі компьютерлердің бір-бірімен қарым-қатынас жасау сипатын олардың функциональдық қызметімен байланыстыру қалыптасқан. Берілгендерді өңдеу процесі клиент серверге күрделі процестердің орындалуына, файлды оқуға, берілгендер базасынан информация іздеуге және т.б сұраныс жібере алады. Сұраныс орындалып, нәтижесін сервер клиентке жөнелтеді. Клиент алынған берілгендерді өңдеп, нәтижені қолданушыға ыңғайлы түрде береді. Осындай байланысқан жүйе клиент сервер деп аталады. Жергілікті желі аймағында да компьютердерді тікелей байланыстыру кезіндегі сияқты клиент және сервер ұғымдары қолданылады.
Клиент-сервер технологиясы - жергілікті желідегі компьютерлерді бір-бірімен байланыстырудың ерекше тәсілі, мұнда бір компьютер (сервер) өз құрылғыларын басқаларға - клиенттерге пайдалануға бере алады. Осыған орай жергілікті желілер бір деңгейдегі желілер және серверлік желілер болып екіге бөлінеді.
Бір деңгейдегі желілерде айрықша бөлінген сервер болмайды, мұнда әрбір жұмыс станциясы әрі сервер, әрі клиент болып қызмет атқара береді. Мұның ерекшелігі - әрбір жұмыс станциясы өз ресурстарының белгілі бір бөлігін барлық жұмыс станцияларының ортақ пайдалануы үшін боліп береді.
Көбінесе бір деңгейдегі желілер мүмкіндіктері бірдей компьютерлерді біріктірген кезде құралады. Бір деңгейдегі желілер жұмыс істеуге ыңғайлы, олардың қызметі де қарапайым түрде жүзеге асырылады.
Егер компьютерлер саны аз болып, олардын негізгі функциясы бір-бірімен мәлімет алмасу болған жағдайда, ең тиімді шешім - оларды бір деңгейлі желілерге біріктіру болып табылады. Мұндай желі кең тараған Windows 98 операциялық жүйесінін басқаруымен жұмыс істей береді.
Мәліметтердің компьютерлерге таралып орналасуы және әр жұмыс станциясының ресурстарын ортақтастыруды өзгерту мүмкіндігі бір денгейдегі желілердегі мәліметтерді заңсыз пайдаланудан сақтауды қиындатады. Осыған орай мамандар мұндай желілердегі ақпаратты сақтау мәселелеріне өте көп көңіл бөлуге мәжбүр болып отыр.
Бір дейгейдегі желілердің тағы бір кемшілігі - олардың жұмыс өнімділігінің төмендігі. Ол ресурстардың әр жұмыс станцияларына бөлініп, жұмыс кезінде олардың әрқайсысының әрі клиент, әрі сервер қызметін атқаруына байланысты болып отыр.
Серверлік желілерде компьютерлердің функциялары алдын ала айқындалған - оның кейбіреуі сервер болып қызмет атқарса, қалғандары тұрақты түрде клиент болып табылады. Компьютерлік желілердің атқаратын қызметтерінің көп түрлілігіне байланысты серверлердің бірнеше типтері бар, олар: желілік сервер, файлдық сервер, баспа сервері, пошталық сервер, т.б.
Желілік сервер желіні жалпы басқару функциясын және есептеу жұмыстарынын негізгі бөлігін атқаратын арнайы компьютер болып табылады. Бұл серверде желіні толық басқаратын операциялық жүйенің негізгі ядросы сақталады. Желілік сервердің жады көлемі үлкен және оның жұмыс жылдамдығы да жоғары дейгейде болуы тиіс. Мұндай желідегі жұмыс станцияларынын функциясына мәліметтерді енгізу мен шығару және сервермен ақпарат алмасу жатады. 
Файлдық сервер термині негізгі функциясы мәліметтер файлын сақтау, басқару және тасымалдау істерінен тұратын арнайы компьютерге байланысты шыққан. Ол өзінде сақталатын және тасымалданатын файлдарды өңдемейді және өзгертпейді. Сервер ол файлдардың мәтіннен, немесе графикалық бейнелерден, немесе электрондық кестеден тұратынын білуге тиісті емес. 

Сервердің файл сервер түрі жиі қолданыста. Өйткені онда желіні қолданудың барлығынан түскен мәліметтер сақталады.

Сондай-ақ осы берілгендерге доступ қатамассыз етеді. Бұл компьютер үлкен жылдамдықты оперативті жадпен, қатты дискілермен, қосымша дискіжинағыштармен қамтылған болуы шарт. Файл сервер арнайы операциялық жүйелермен жұмыс жасайды. Ол операциялық жүйе бір мезгілде қолдануға доступ ашуы керек. Файл сервер файылдары:

1) берілгендерді сақтау;

2) архивтеу;

3) жөнелту;

 4) әртүрлі қолданыстағы берілгендерді өзгертуді синхрондау;

   Кейде файл сервер жеткіліксіз болсағ онда желіге бірнеше серверлерді қосуға болады. Әдетте орталықтандырылған ЭЕМ хост машина деп аталады. Берілгендерді өзгертуді орталықтандыр жүйелерінде қолданылады.

Жалпы файлдық сереверде монитор мен пернелік тақта болмаса да болады. Файлдық мәліметтердегі барлық өзгертулер клиенттік жұмыс станцияларында жүргізіледі. Сондықтан клиенттер серверден файлдарды көшіріп алады да, керекті өзгерістерді жасап, нәтижесін қайтадан серверге қайтарады. Мұндай желі жұмысы - көптеген тұтынушылардың бір үлкен ортақ базаны біріге отырып пайдалануы кезінде өте тиімді болып табылады. Үлкен желілерде бір мезетте бірнеше файлдық серверлер пайдаланылуы мүмкін.
Баспа сервері (принтер-сервер) желі адаптері көмегімен мәлімет тасымалдау ортасына қосылған баспа құрылғысы болып табылады. Мүндай желілік баспа қүрылғысы басқа желі құрылғыларынан тәуелсіз күйде өзі жеке жұмыс жасайды. Баспа сервері желідегі барлық серверлерден және жұмыс станцияларынан тапсырма ала отырып, олардың мәліметтерін басып шығарады. Баспа сервері ретінде қуатты, жұмыс өнімділігі жоғары принтерлер пайдаланылады.
Желілік басып шығарғыш - бұл жекелеген пайдаланушылар ортақ қатынаса алатын басып шығарғыш. Басқа пайдаланушылар сіздің басып шығарғышыңызға қатынауын ашу үшін мына әрекеттер орындалады:

1. Бастау -  Басып шығарғыш пен факстар әмірін орындаңыз, Сіздің компьютеріңізге қосылған таңбашалары бар барлық басып шығарғыштармен факстарды  сұқбат терезесі ашылады. 

2. Сіз қатынас құруды қалаған сол басып шығарғыштың таңбашасын табыңыз да, онда тінтуірдің оң жақ батырмасын шертіңіз және ашылған мәзірден Ортақ қатынас құру мәзірін таңдаңыз.

3. Ашылған терезеде  қатынас құру қосымшасына өтіңіз де, ауыстырып қосқышты берілген компьютерге ортақ қатынас құру жағдайларына орнатыңыз. Белсенді етілген мәтіндік мәтіндік өрісте желіні пайдаланушылардың бәрі көре алатын берілген басып шығарғыштын атауын енгізе аласыз.

4. Жарайды батырмасын басамыз.
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6-сурет. Жергілікті желіде принтерді пайдалану

Жергілікті желі ауқымды желімен өте көп мәлімет алмасатын болған жағдайда, пошталық серверлер пайдаланылады. Олар электрондық пошта мәліметтерін өңдеу үшін қолданылады. Интернет желісімен тиімді қатынас кұру үшін Web-серверлер пайдаланылуы мүмкін. 
Клиент сервер архитектурасы бір рангілі локальді есептеу желісін де, ерекшеленген серверлі желіні де қолдана алады. 

1.4. Желілердің ерекшеліктері

Бір рангілі желі – біркелкі басқару орталығы жоқ желі және біркелкі берілгендерді сақтау құрылғылары жоқ желі.

Мұндай желілер желілік операциялық жүйе барлық жұмыс станциясына орнатылады. Басқаша айтқанда желінің әртүрлі станциясы клиент жұмысын да, сервер жұмысын да орындай береді. Ол басқа жұмыс станцияларының сұранысын қанағаттандырып, оларға өзінің сұранысында жібере алады. Желі қолданысына басқа станцияға қосылған құрылғылар, дискілер, принтерлер ашық мүмкіндік береді.

Бір рангілі желінің ерекшіліктері: бағасы төмен, мықтылығы жоғары.

Кемшілігі: желінің жұмысының тиімділігі станциялар санына тәуелді.

Желіні басқарудың қиындылығы: информацияны қорғаудың қамтамассыз етудің қиындылығы, станцияның программалық жабдықтарын жаңалау, өзгерту.

Ерекшеленген серверлі желі жиі қолданыста, мұнда сервер мүмкінділігі барынша кеңейтіліп қойылады. Сервистік функциялармен қамтылады, желі серверіне желілік операциялық жүйе орнатылып, оған бірнеше сыртқы құрылғылар  қосылады. Мұндай желінің жұмысын ұйымдастыру үшін “жұлдыз” топологиясы қолданылады.
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Ерекшеліктері:

· информацияны қорғау жүйесінің мықтылығы;

· жылдамдықтың жоғарылығы;

· жұмыс станциясының санына шектеу қойылмауы;

· басқарудың қарапайымдылығы;

Кемшілігі: 

· бір компьютерді сервер түрінде ерекшелеуге байланысты бағасының            қымбаттауы;

· Желі мықтылығы серверге тәуелді;

· Бір рангіліге қарағанда икемділігі төмен;

Желілік операциялық жүйелері: LAN сервер, Windows NT, NetWar.

Локальді есептеуіш желілердің физикалық ортасы   есептеуіш желінің абоненттері арасында информацияны тасымалдауды қамтамассыз етуші физикалық ортасы. Локальді желіде қолданылатын кабельдің үш типі бар:

1) сымдардың есулі жұп түрі (витая пара проводов) – есулі жұп өзара изоляцияланған. Ол жөнелтілетін сигналдарды қорғап, сыртқы электромагнитті өрістерінің әсерін азайтып тұрады. Қарапайым түрі – телефонды кабель. Су қадамы және гуолеция әртүрлі болуы мүмкін. Есулі жұптың негізгі ерекшелігі:

· кедергіден қорғаудың төмендігі;

· информацияны жөнелту жылдамдығының төмендігі;

Есулі жұптың эрандалған түрі бар. Ол технологиялық дамытылған. Соған сәйкес бағасы да өседі.

2) Коакцальды кабель – информацияны жөнелту жылдамдығы 10..50 Мбайт/с өндірісте қолдану үшін оның екі типі шығарылады:

· қалың;

· жұқа;

Әрине қалың кабель жұқаға қарағанда мықты және сигналды қажет амплитудамен үлкен қалыңдықтарға жөнелте алады. Бұл кабель түрлері сыртқы әсерден қолғалған, мықтылығы жоғары.

3) Талшықты кабель (оптовалоконный кабель) электромагниттік өрістің әсерін сезбейтін, өзі ешқандай жарқыл шығармайтын орта. Бұл кабель түрі құпия информацияларды жөнелту қажет желілерде қолданылады. Информацияны жөнелту жылдамдығы 50 Мбайт/с, қымбат, тасымалда қолданыста аз.

Локальді есептеу желілерінің топологиялары 3 түрлі болады:

1) сақиналық;

2) шиналық;

3) жұлдызды;

     Кез келген компьютерлік желілі түйіндердің жиынтығы деп қарастыруға болады. Түйін – желілік ортаға қосылған компьютер немесе кез келген құрылғы. Түйін (узель) деп аталады. Топология желі түйіндерінің біріктіру схемасын көрсетеді. Тұйықталған сызық, элипс, қисық, т.б сақиналық топологияға , ал тұйықталған сынық сызықтар шиналыққа жатады. Сақиналық топологиядан бір түйіннің шығысы 2-шісінің кірісіне жалғанады. Информация сақина бойымен бір түйіннен екіншісіне жөнелтеді. Қолданушы мен жөнелтуші арасындағы компьютер жөнелтілген информацияны трансляциялайды. Қабылдаушы түйін тек өзіне адрестелген хабарламаны қабылдайды. Бұл түр кішігірім кеңістікте ұйымдастырылады. Кабельдің кез келген типін қолдануға мүмкіндік береді.

Кемшілігі:

· желідегі бір түйіннің істен шығуы сақина бүтіндігін бұзады, арнайы шараларды қолданғанды талап етеді.

Шиналық топология коакцальды кабель түрі қолданылатын бұл түрде берілгендер шина бойымен таратылады. Аралық түйіндер ешқандай трансляция жасамайды. Информация барлық түйінге бірдей жеткізіледі. Бірақ хабарламаны тек адресат қана қабылдайды. Яғни параллель қызмет көрсету орындалады. Бұл түр информацияны жөнелтуді жылдам ұйымдастырады. Сондай-ақ, әртүрлі жүйелерге сәйкес адаптация ұйымдастыруға болады.

Кемшілігі: бір желінің ішінде әртүрлі типті кабельдерді қолдануға мүмкіндік бермейді. Желінің ұзындығы қысқа, жұлдызды топология орталық түйін концепциясына негізделеді. Орталық түйінге перифериялық түйіндер қосылады. әртүрлі перифериялық түйін өзінің жеке байланыс мениямен орталық түйінге жалғанады. Барлық информация перифериялық түйін арқылы жөнелтіледі. Информациялар қайта трансляцияланады., немесе информациялар ағымы маршрутталады.

Артықшылығы: қарапайым адаптерді қолдануға мүмкіндік береді.

Кемшілігі: желінің жұмыс орталығы түйінге толық тәуелді.

Қазіргі кезде есептеуші желілер әртүрлі топологиялардан құрастырылған 

қүрделі желіде қолданылады.
ІІ –Тарау.  Желі арқылы Macromedia flash технологиясын оқыту мүмкіндіктері 
2.1.Macromedia Flash жүйесімен танысу

       Macromedia Flash MX 2004 және  Macromedia Flash Professional 2004 көптеген қызықты интерактивті мультимедиялық презентацияларды дайындауға мүмкіндігі көп.Flash те векторлық графикамен және анимациялар мен жұмыс істеуге болады.Әдетте бұл программамен манипулятор, растрлі графика , видеоматериялдарды монтаждауға және дыбыс монипулятор файылдарымен жұмыс істеуге болады. Flash – тің көмегімен графикаларды безендіруге көптеген видео презентацияларды соның ішінде Электронды комерциядан  бастап видео айындар мен мультфильмдер жасауға болады.
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7-сурет. Macromedia Flash програмасы.
Жұмысты бастамас бұрын Flash программасын Пуск=> Программы => Macromedia=> Macromedia Flash MX командасы арқылы қосамыз.
Macromedia Flash MX 2004 және  Macromedia Flash Professional 2004 –бұл бір программаның екі түрлі версиясы. Flash – те анимация ,эффекті ,векторлық графика ,интерактивті мысалдар, программалар ,Web – сайтттагы презентацияларды жасауға болады. Flash – те істеген жұмыстарды FLA форматта сақтайды. FLA форматында керекті ресурстарды ,видеоматериалдар дыбыстар мен кодтар сақтайды.   Қазіргі таңда   Macromedia Flash MX   Интернетті қолданатын барлық адамдарға танымал. Көптеген қолданушылар  Flash – ті үйренуді асыға күтті. Өйткені   Flash – тің мүмкіндіктері бүкіл әлемге әйгілі еді.    Macromedia Flash пен көруге болатын көптеген сұлулықты ,   тыңдай алатын дыбыстарды істейалатын мүмкіндігі көп.   Macromedia Flash –те жұмыс істеудің 5-мүмкіндігі.  

· Macromedia Flash MX туралы түсінік және оның мүмкіндіктері мен принциптері. Macromedia Flash MX стандартты функциялары.

· Macromedia Flash MX – тегі ActionScript тілі және мультимедиялық файылдар туралы түсінік.

· Үшінші главада – анимацияның мүмкіндігі, анимацияны құру, қабаттар мен фондық эффектілер.

· Төртінші главада электрондық оқулықтар туралы түсінік.Электронды оқулықты құру, дистанционды оқыту  олармен жұмысістеу бағыттары.

·  Macromedia Flash MX арқылы жасалатын  мультимедиялық  фильмдер. 

2.2.Macromedia Flash MX технологиясы

         Macromedia Flash MX - өте мықты программа. Flash  суретшілермен дизайнерлерге өте керекті құрал болып табылады. Web – сайтттагы  проектілі анимациялар мен дыбыстар беру үшін қолданылады. Алғашқы кездері Flash – тің мүмкіндіктері жоғары дәрежеде емес еді Macromedia корпорациясы жаңа Walt Disney серверін ұсынсынған ға дейін.

        Бұл  Flash технологиясында үлкен реклама жасады.Көптеген дизайнерлік студиялар Web парактарын Flash технологиясымен безендіру үшін пакет программаларын көптеп сатып алды. Алғашкы кездері программа Splash Animator деп аталып  атағы жоқ Future Animation фирмасында РС – комптютерінде мультфильмдер жасау үшін қолданылды.

        Суретшілер мен аниматорлар азғана мүмкіндігімен жұмыс істеп жүрді. Macromedia фирмасы  пакеттерді сатып алып Flash деп атын өзгертіп мүмкіндіктерін айқындағанынша. 

        Macromedia фирмасы  интерфейсін программаның автоматизациясын ауыстырды. Мультимедиялық программа атымен интерфейсін гана ауыстырып қоймайпакетті рынокқа шығарды. . Macromedia фирмасы   тек сыртқы пішінін өзгертіп қоймай ішкі порограммаларында өзгертті.

        Flash – тің интерактиві Action Script сценариына  қолдануына байланысты мумкіндіктері кең жайылды.Өте қиын behaviors стильмен электрондық магазиндер құрды. Flash  Web арасында  терең дамыды. 

        1996жылы Flash технологиясы шыққаннан бастап Web сайттарда мультфильмдердің  көптеген түрлерін құрастырды. 

        Macromedia Flash -   растрлі және векторлы графиканы пайдаланып мультимедиялық және интерактивті материялдарды, аудио, видео  дайындайтын құрал.  Клиптің копиясымен Flash –клиптің қайжерде орналасып тұрғанына қарамастан Web сайыттарда қарапайым презентация ретінде  Internet – тің көмегінсіз жұмыс істеуге болады.   Оның  дизайнымен безендіруі өзгеріссіз қалады. Көрініс терезесінің  көлемін өзгерткенде де, оның                                                                                                                                                                    позициялы элементімен дизайны өзгермейді. Flash – системасы векторлық грпафика класына жатады. Осы  системангың көмегімен  дайындалған сурет математикалық түрде сақталады: қисық векторы жеке бір сегмент болады. Бұдан басқа бұл сегмент түспен , қалыңдықпен соңғы нүктедегі координатам ен ерекшеленеді. Векторда суреттің көлемін құндылығын жоғалтпай өзгертуге болады.

        Flash –тің басты міндеті сіздің салған суретіңізді қимылдату үшін не істеу керектігін үйрету.        Flash – пен көптеген графикалық видео презентацияларды  безендіруге болады.  Flash көптеген универсалды платформаларға үсынылған.

Сонымен   Macromedia Flash бұл:

● Векторлы графика. Векторлық графика математикалық координаттардың нүктесін және оларды қосатын құрал.Векторлар түзудің қисықтығын анықтайды.Математикалық есептеулерге  байланысты оның көлемі өз құндылығын жоғалтпайды. Графикалық форматта шеңбердің диаметрі 100 пиксель,ол минимум 10 килобай – 100х100 пиксель орынды алады, нүкте нүктесіне дейін.Ал оны векторлық форматта беру үшін оның радиусын берсек жеткілікті.  Растрлі графикадан ерекшелігі көлемін өзгерткенде оның құндылығы өзгереді. ( көлемін кішірейткенде оның кейбір кішкентай нүктелері жоғалып кетеді, ал көлемін үлкейткенде – квадраттар пайда болуы мүмкін.)вектормен суреттеген көрініс нақты ,анық болып шығады.

● Растірлі графика. Flash – те тағы растірлі графика бар. Манипуляциялық көрініс растірлі  нүкте көлемде берілмейді, барлық сурет көлемінде беріледі. Растрлі көрініс әр түсті нүктелерден   тұрады. Бұл жағдайда әр нүктенің  түсі жайлы мәліметті сақтап отыру керек . Векторлық суреттің  растрлік көріністің көлемін салыстырғанына байланысты. Flash импортталған және архивтелген файлдарды JPEG тен сақтауға мүмкіндік береді. Роликке растрлік, графикалық және векторлық көріністерді:*.EMF,*WMF,*EPS,*AI,*DXF,*DIB,*JPG,*GIF, *.PNG. импорттауға болады. 

●Анимация. FLASH PLAYER -FLASH фильмді                                                                                                                                                                                                                                                                                                                                                          қосқан  кезден бастап жүктеледі.

● Дыбыс.FLASH-ролигінде   дыбыстық файылдарды *.WAV,*.AIFF. форматта қолдануға болады.  FLASH – ті қолдану сізге көп еркіндікті береді: осыған байланысты көп емес дыбыстық эхффектілерді беруге болады, кнопканы басқан кезге,  фондық  режимде дыбыстық жолақтарға. Сіз роликке музыкалық немесе дыбыстық  жолақтарды, визуальдық компоненттермен беруге болады. 

● Трансформация. Біз компьютер қолданғанна бастап, жұмысымызды жеңілдету үшін, анимацияны  қолдан жасамаймыз. Ол жеңіл қозғалысты, форманы түсті талап етеді. FLASH  бұны автоматты түрде өөзі істейді. Ол үшін трансформацияны пайдалану қажет. Бұл үшін бастапқы және соңғы форманы, сағатты  беру қажет.Тракнсформация орналасуын да қамтамасыз етеді. 

● Специльные    эффекты. Спецэффектіні қолдану үшін әр қабатқа  өзінің техникасы қолданылады, (мына типте Layers  Photoshop), және де көгілдір масканы да қолдануға болады. Дизайнның активті элементі. Кез  келген графикалық элементті қолдануш ымен активировать етуге болады, роликті басқаруға , дыбысты қосуға жәнек тоқтатуға ,URL- ресурсын қасуға, видео кнопкалармен менюді функионалдауға  болады. Кнопка үш түрде болады(қарапайым, тышқан тәріздес, басылымды).

● Роликтің өлшемі. Векторлы форматты қолдану обьектімен жұмыс істеуде, қарапайым графикалық  форматқа қарағанда       клип файлдың көлемін кішірейтуге мүмкіндік береді. Экспорт анимациясы- GIF – 27 килобайт AVI – 8 мегабайт. 

● Роликтің автономды проигрывтелі. FLASH – те құрылған ролик Internet  желісінде  ғана көрсетпейді,автономды арнайы проигрывательиен де көрсетеді(Window және Macintosh). Кезкелген JAVA виртуальді  машинасында жұмыс істейтін JAVA проигрывателі бар. Windows – та дискетамен CD ROM презентациясымен қосуға болатын автономды Exe – модулін дайындауға болады. Бұл түрде дайындалған презентация  Internet жасалған презентаци ядай болып көрінеді. 

Жұмыс алаңы
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8-сурет. Жұмыс алаңы.
Инструменттер құралы. Жаңа инструменттер құралына бір қарағаннан Flash  программасының  пофессионалды болғанын байқаймыз. Мысалы  үшін   Line, Oval, Rectangle, Pencil  және Hand  қарапайым опция болған, ал қазір жеке- жеке құрал. Жаңа Rectangle  опциясы дөңгелер бұрыштарымен төрт бұрыш жасай алады.
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9-сурет.Инструменттер құралы

1- Панель құралдары

2- Көру құралы

3- Түстер параметрі

4- Қосымша құралдар

                               2. 3.  Macromedia Flash MX  командалары

· Ерекшелеу құралы   (стрелка)  -   графикалық обьектілерді өзгертуге      және ерекшелеуге арналған.

· Snap – Басқа обьектіге немесе орнына жылжыту,өзгерту құралы. Дұрыс қадаммен орындасаңыз  обьектіні қиналмай орнына қоя аласыз.

· Smooth -     Қисық  сызықтарды  түзулеу құралы.

· Straighten -  Түзету.  Smooth –қарағанда бұрыштарды түзулейтін құрал.

· Rotate – таңдалған обьектіні бұрау.

· Scale  - таңдалған обьектінің көлемін өзгерту.

·  Лассо – обьектінің облысын ерекшелеуге арналған. Біра ол бірнеше спецификалды. Бұның көмегімен обьектінің іші формалар,жұмыс облыстарын редакторлау үшін ерекшеленеді.

Модификаттар:

· Magic Wand –сиқырлы таяқша. Керек түспен облысты қырқып алады.

· Magic Wand Properties -  сиқырлы таяқшаның режимін орнату   құралы.

· Polygon -  көпбұрышты. Обьектілерді түзу сызықтармен обрисовкалау

· Сызық –  жұмыс столының обьектісі.Түзу сызықтар сызу үшін қолданылады.

· Stroke Color -  Түс таңдау палитрасы.

·  Fill Color -  Түс таңдау заливкасы.

· Тіктөртбұрыш - Тіктөртбұрыштар мен квадраттар жасайтын құрал.

· Round rectangle radius -  Нүктелердің радиусын  беру. Бір  Corner Radius модификаторды шертсеңіз  Setting, Rectangle радиус беретін нуктелер шығады.

· Pencil Mode -   қарындаш құралы.

· Ink – сақталмаған сурет

· Brush Mode – кист режимі.

· Paint Normal -   толық бояу.

· Paint fill – жиектерін боямай заливканы қолдану.

· Paint Behind -  обьектіден кейін  фонды бояу.

· Paint Selection – ерекшеленген облысты бояу.

· Paint Inside –   обьектінің ішін бояу.

· Brush Size – кисттің өлшемін таңдау.

· Brush Shape –  кисттің формасын таңдау.

· Пипетка  - заливканы көшіріп алуға мүмкіндік береді.

· Ластик – форманы,фигураны,сызықты өшіру үшін қолданылады.

· Рука – жұмыс парақ үстінде оңай жылжыту.

· Лупа – үлкейтіп көрсету.Артық жерлерін алып тасатап жөндеу.

· Текст – Мәтін жазу.

· Векторлық корекция – графикалық обьектілердің формасын өзгерту.

· Перо – Векторлық обьектіге  сызық чызу.

· Don’t Close Gaps -  жабулы обьектілерді бояу.

· Close Small Gaps – обьектілі зөаливка

· Stroke Color -  Түс таңдау палитрасы

· Smooth -     Қисық  сызықтарды  түзулеу құралы.

· Rotate –таңдалған обьектіні бұрау

· Polygon -  көпбұрышты. Обьектілерді түзу сызықтармен обрисовкалау

Уақыт шкаласы. Уақыт шкаласымен проектінің структурасын бағалауға және обьектіні жылдам көруге болады.Кадрларды жылжытуға болады.Сіз уақыт шкаласымен  статистикалық немесе трасформациялық  кадр екенін оңай ажыратасыз. 

                   1
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10-сурет.Кадрлармен жұмыс істеу терезесі

1-ші бетті редактрлеу

2-ші символдарды редактрлеу

3-ші орталыққа даярлау

4-ші калькірлеу

5-ші калькірлеуді өзгерту
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                                                                        3          2
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11-сурет.Қабаттар терезесі


1-ші контур түрінде қабаттарды көрсету

    2-ші қабаттарды блокқа қою

    3-ші қабаттарды жасыру

    4-ші қабаттар қосу

2.4. Macromedia Flash –тің принциптері

    Flash – те проект жасағанда және оны басқа программалармен салыстыра отырып графикалық суреттерде Web – дизайнда  олардан мүмкіндігі көп екендігін байқауға болады. 

1. Элементтерді   қолдануда   бірнеше  рет  қайталануы.

2. Кадырларды өзгерту үшін біріктіргенді. (motion tweens),  командалары кадырлардың қайталануын автоматты турде санауын көрсетеді.

3. Кадырлардың трансформациямен бірігуі. (shape tweens), командалары кадрлардың трасформациямен автоматты турде бірігіп,  проектінің  жылдамдығын  көрсетеді.

4. Қарандаш   құралымен   сызылған сызық қаламсапқа қарағанда  аз көлемді талап етеді. (пунктир, линий т.б)  

5. Қабаттарды   қолдану   клиптің   бөлімдерін  бөлуге қолданылады.

6.  Векторлық графикаға байланысты әр санның  шрифтімен стилін  қысқарту.

7.  Жоғарғы    дәрежелі   пайдалы  музыканы  МР3 форматта қолдану.

8. Растрлік көріністерді  анимация мүмкіндігінде қолдану, оның статикғалық элементтерінің фондық түсі.

9.  Actions  Script    бөлімдерінде    кадрларды   бөлуді  қолдану.

10. Әр  қабатқа обьектілерді біріктіріп қою.

11. Бір обьектінің түрлі құралмен фондық түсітік эффектілерін өзгерту .

12. web – safe   бірлік  политрасында  түстік  браузердің айырылуын қолдану. 

13.   Library компонентінде кезкелген обьектіні тез тауып көлемін өзгертуге борлады.

14. Бастапқы проектіге  жаңа проектіні қолдану.

Web сайтпен   Internet – те программаны өзгерту үшін кейде  гипермәтіндік текстке HTML тілі қажет болады.

     Flash технологиясы HTML тілінің орнына таласқан емес , бірақ толық роликтік парақты     Flash  - пен сформировать етуге болады. 

Қабаттық көрініс. Маркер терезеде  бейнеленген ағымдық кадрды көрсетеді. Қандай да бір кадрды сілтегенгенде маркер оған автоматты турде орналасады.

    Қабаттар    - қабаттар тізбегінің сол жағында орналасады. ОЛның астында қабаттарды қосуға, алып тастауға мүмкіндік беретін түймешіктер бар. Әрбір қабатты көрінбейтін   етуге және оны редакциялауға тыйым салуға болады. 

     Кадрлар шкаласы – сіз қарапайым және шешуші кадрларды қосу және алып тастау мүмкіндігіңіз бар. Егер қандай да бір кадрда контекстік мәзірді шақырсақ (тышқанның оң пернесін басу арқылы) сіз жасауға болатын әрекеттер тізбегін көресіз. Шкалада шешуші болып табылатын (мұндай кадрлар қара дөңгелектермен орналасады) әрекеті («а» әріпі) немесе белгісі(қызыл жалау онан соң белгінің оты) бар кадрланр туралы ақпарат көрінеді. Түс те кадрлардың түрі туралы айтады. Сұр түс бұл шешуші кадрды (кeyframe) дәлме дәл қайтайталайтын кадрлар. Көкшіл не жасыл түс кадрлардың  Flash –пен басқарылғаны туралы айтады және ақырында, ақ немесе босжолақ кеңістік бұл кадрларда ештеңе жоқ  екенін білдіреді. 

    Көлеңкемен басқару түймешіктері – бұл алдынғы және кейінгі кадрлардың арасындағы айырмашылықты көру үшін, көршілес кадрларды калька арқылы бейнелеуге мүмкіндік беретін түймешіктер. Мұндай бейненің тереңдігі маркердің екі жағынан беруге болады.

2.5. Flash’те анимациялар құру

Flash’тегі анимация “мултикте” қолданылатын объектілердің қасиетін өзгертуге негізделген. Мысалы, мультиктерде объектілердің пайда болуы немесе жоғалуы мүмкін, сондай-ақ объектілер орнын, формасын, өлшемін, түсін, мөлдірлілігін т.б. өзгертуі мүмкін. Flash’те объектілерді анимациялаудың үш түрлі механизмі қарастырылған:

· кадрлап (“классикалық”) анимациялау – автор, құрып отырған мультигінің әр кадрын өзі безендіріп отырады.

· автоматты анимация (tweened-анимация), құрушы тек алғашқы және соңғы кадрларын жасайды, ал Flash аралық кадрларды өзі генерациялайды; tweened-анимацияның екі түрі бар: объектілерді жүргізуге негізделген (motion-animation) және объектілерді трансформациялауға (формасын өзгертуге) негізделген (shape-animation);

· сценарий негізінде құрылатын анимация, сценарий обьектілердің өзгеріп отыруын Flash’тің өз тілінде сипаттайды, ол ActionScript деп аталады; бұл тілдің синтаксисі Web-публикацияда қолданылатын  басқа сценарий тілдерінің синтаксисін (мысалы, JavaScript және VBScript) еске түсіреді.

Бұл механизмдердің әрқайсысының артықшылығы болғанымен кемшіліктері де бар. Көп жағдайда tweened-анимацияның мынадай екі артықшылығы болады:

· біріншіден, автор әр кадрды жекелеп жасап қиналмайды;

· екіншіден, мұндай мультиктерді жүргізу үшін Flash тек алғашқы және соңғы кадрларды ғана сақтап отырады, бұл филмнің көлемі аз болуын қамтамасыз етеді.

Тweened-анимация қарапайым сюжеттер жасауға ғана күші жетеді. Ал ActionScript сценарийлері арқылы объектілердің жетерліктей күрделі құбылыстарын жасауға болады, бірақ... Бірақ ол үшін ActionScript тілін жетік үйрену керек. Басқа сөзбен айтқанда, өзіңіздің жеке мультигіңізді жасауға кіріспей тұрып, оны реализациялау механизмінің қай түрін таңдайтынымызды анықтап алуымыз керек.

Қабаттар  мен  қозғалысты анимация (motion tweening).Енді элиптикалық орбита обьекттісін жасауға кірінісіміз ол тағы да  жұмысы турде көрсетілгенімен, жиегі көк түсті болады, онан соң бізде келесі пайда болады:
      Біз біздің планетамыздың ортасында орналасқан элиптикалық орбитаны жасап болған соң планета екі секторға бөлінеді. Бұл   Flash техналогиясында обьектілер олардың қиылысу нүктелерінде секторға бөленетіндіктен болады. Бұл ерекшелікті баста қалайсыз көрінгенімен   соңына өте күрделі  роликтер жасау кезінде өте қажет. Планета мен орбитаның мұндай секторларға бөліну кезінде өте қажетті обьектіде екі рет шертпе жасап, сосын Modify → Group мәзірінің пунктін (немесе  Ctrl + G  пернелерінің жиыны )  пайдалану жеткілікті. Group командасы обьектілерді бір топқа топтастыруға мүмкіндік береді. Бұл командадан  бас тарту үшін Modify → Ungroup   топтамасын іске қосамыз. 

       Енді планета өз өсінің айналасында айналатын тиімділік үшін біз ең қарапайым, бірақ өте тамаша тәсілді пайдаланатын  болып шештік. Маркердің көмегімен планета ортасында біз оның градиентін бірінші және соңғы кадрда белгілейміз. Сонымен, біз ойнамалы басты бірінші кадрға ауыстырамыз және маркердің көмегімен градиентті планета шегінен алып шығып, оны солға көшіреміз. Мұны оның ортасы планета мен    орбита ортасына сәйкес келетіндей етіп және градиетн жиегі мен планета жиегі бір сызықта болатындай етіп жасаймыз.  Соңғы кадрғада осыны жасаймыз, тек градиентті солға ауыстырамыз.

     Фильмді дыбыстандыру.

 Спутник өз өсі бойымен орбита мен планетада айналуы кезінде алдымен дыбыстық фрагмент орналасатын жаңа қабат жасау керек. Жаңа қабатты Дыбыс деп атап оны ең жоғары ға орналастырамыз. Енді өз фильмімізге дыбыс қосу үшін біз дыбыстар кітапхананы қолдануға немесе өзіміздің жеке файлымызды импорттауға міндеттіміз . Flash программасы келесі форматтағы файлдарды импорттауға мүмкіндік береді. MP3    (Mpeg-1 Audio     Layer 3), WAV (windows wave ), AIFF немесе   AIF /AUDIO INTERCHANGE FILE FORMAM QUIC TIME-ді  тікелей   Flash програмаасына импорттауға болмайды. Алайда бұл аудиофайлдарды WAV немесе   AIFF  форматында сақтап Flash те импорттауға дайындауға болады. Бұл үшін компьютерде Quick Time Pro 4 немесе оданда жоғары рограмаасын орнату керек, оны  www. Apple.com  адресі бойынша  Web – тармағы   Apple – ден табуға болады. Біздің анимациялық фильміміз  Web – ке арналғанджықтан, оған жаңаша қызықты ізденіс қосу керек.

       Start -  туралы нұсқа алдыңғыға ұқсас ерекшелігі оқиғаның кезекті басталуында алдыңғыны шығару аяқталмасада дыбыстың жаңа данасын шығару басталады.   

       Stop туралы  -бұл опция     Start       опциясымен ұқсас, ерекшелігі бөлінген дыбысты шығ 
Error opening URL "file:///F|/Новая%20папка/test.swf"ару .        Stop  синхрондау оқиғасы басталғанда тоқтайды. Бұл опцияны белгілі дыбысты шығаруды тоқтатуға пайдаланады.

Stream туралы – ағымдық дыбыс. Flash анимация  мен ағымдық дыбыстың күштеп синхрондауды қамтамасыз етеді, мысалы, егер анимация кадрлары Web – бетте ағымдық дыбыс секілді жылдамдықпен шығуға үлгермесе, Flash плеер кейбір кадрларды өткізеді, ағымдық дыбысты шығару анимация аяқталғанда тоқтайды, одан басқа ағымдық дыбыс ешкашан ұзаққа созылмайды.  Біздің ролигімізге сәйкес келетіндіктен біз Stop – ты таңдаймыз.

· Loops  (Циклдар) – бұл жерде дыбыстандырудың ұзақтығын анықтауға болады, ол қайталанған дыбыстың саны ретінде анықталады, бұл сандар өріске енгізу керек, мысалы  егер 3 – секундтық дыбыс 30 секунд бойында естілсе , Loops өрісіне 10 санын енгізу қажет. 100 мәнін береміз, себебі ролик интернетке есептелген. 

Енді бізде не алынғанын тексереміз, енді бақылаушының көмегімен емес, Cantrol → Test Movie  мәзірі пунктінің немесе  Ctrl+ Enter   түймешіктері жинағының көмегімен басамыз.

Фильмді жариялау. Енді біз филтмді жариялаумен айналысамыз. Алдымен бізге жариялауға қажетті параметрлерді қоямыз, бұл үшін  File → Publish Settings мәзірінің пунктін немесе Ctrl + Shift + F12  пернелерінің түймешіктер жиынтығын пайдаланамыз, бұдан соң экранда төмендегі терезе пайда болады. 
      Ол үш жинақтан тұрады:  Formats, Flash, HTML. Бірінші жинақта жариялаудан соң алу,а болатын файл түрлері көрсетілген біз   .swf,.html,.gif,.exe. – ні таңдаймыз. Біз  Use default names  қатарындағы белгіні алып тастай аламыз, бұл жариялану кезінде  басқарылатын файлдардың атын өзгертуге мүмкіндік береді, бірақ бұл бізге қажет болмағандықтан  оны өзгеріссіз қалдырамыз.Енді келесі жинаққа көшеміз .

· Load Order -   (жүктеу реті). Бұл параметр Flash, программасы фильмнің бірінші кадрын оны қосымшаға немесе ұмтылушыға жүктегенде қалайша көрсетілетінін анықтайды.

· Button Up (төменнен жоғарыға ) – қабаттар өсуші ретте жүктеледі, алдымен ең төменгі сосын кейінгі қабаттар жасалынады.

· Top Down  (жоғарыдан төменге) - қабаттар  шешу ретімен жүктеледі

· Generate size report (есеп беру) осы шолаушаны орнатқанда   Publish (жариялау ) командасы мәтіндік қосымшада қарауға txt  файлн шығарады.

· Omit Trace actions (трассалау әрекетінен бас тарту) Бұл параметрді таңдағанда Flash  Action script тілін трассалаудың кез келген әрекетін жояды.

· Protect from import ( импорттау операцияларынан қорғау) Бұл параметр Internet  - тегі  SWF файыцл қаіпсіздік шараларына кепілдік береді. Бұл жалаушаны орнатқанда  SWF файлы Flash 5 редакциялаудың авторлық ортасынга кғері импорттауға немесе ооны өзгертуге  болмайды.

· Debugging Permitted  егер бұл жолауша орнатылса, сіз фильмді қою ортасында немесе  Flash Debug Player қосымша моделі немесе сәйкес басқару элементі  қолданылатын  Web  браузерден  Debugger  псанеліне рұқсат аласыз

· Password  (пароль). Егер сіз  Debugging Permitted   жолаушасын қойсаңыз, онда бұл алаңда  Debugger панеліне рұқсат алу үшін пароль енгізе аласыз.

· JPEG Quality (JPEG сапасы). Бұл бөлім мен қатар орналасқан мәтіндік алаң  Flashфильміндегі бас бейнеге жататын  JPEG ті сығу деңгейін анықтайды

· Audio Steam (Аудиоағыш). Бұл параметр ағымдық сығу үшін қазіргі сығу сызбасын бейнелейді  Түймешігінің көмегімен параметрлерді қоюға болады.

·  Audio Event  (аудио оқиға). Бұл параметрде алдынғы сияқты, бірақ   Event оқи оқиға синхронизациялы дыбыстар үшін.

· Override sound setting   (дыбыс параметрлерін қайта жазу). Егер    Audio Event   және Audio Steam параметрлерін қолдану (барлық ағымдық дыбыстар мен дыбыстық оқиғалар үшін) және Flash кітапханасында берілген нақты дыбысты сығуды кез келген сызбасынан бас тарту қажет болғанда осы жолаушаны орнату қажет.

· Version (версия). Бұл жерде сақталған SWF – файлы үшін Flash программасының версиясымен таңдауға болады. Ең  жақсы фильмді бүкіл версияда көру  мүмкін болу үшін версияны төмен қойған жөн, әйтпесе, егер бұл файлды 5 версияда көрсек ол МХ версиясында сақталады да, кейбір проблемалар туындайды.

Бұл жинақта келесі HTML  жинағындағы секілді бәрін өзгеріссіз қолдырамыз. Енді  Flash → Publish немесе  Ctrl + F12  мәзірімен пунктін таңдаймыз, одан соң фильм  жарияланып, біз таңдаған жаңа файлдар, яғни  suef, .html, .gif, .exe пайда болады.

   Ctrl + Shift + G  пернеелерінің жиынтығын жасау керек. Біздің орбитамыздың  кесінділерін топтастырып, оның айналасында тік бұрыш пайда болады – бұл топтастыру командасының орындалғанын білдіреді, егер бұл болмаса, операцияны қайталауға тура келеді.

   Топтастыруды орындап, орбита мен планетаны бір мезгілде бөлеміз (Shift пернесін басып ұстап тышқан бағытын обьектілерге апарып) де оларды ортаға теңестіреміз, бұл үшін Ctrl + K  пернелері жиынтығының теңесу терезесін ашамыз немесе Window → Panels → Align Мәзірінің пунктін таңдаймыз. Бұл терезеде көптеген теңестірулерді көруге болады, бірақ бізге олардың екеуі ғана қажет болады. Align Horizontal Center  мен Align Vertical Center   өз обьектілерімізді теңестіріп, Rotate (айналдыру ) түймешігін басып немесе Modifi → Transform → Rotate   мәзірінің пунктін таңдап планетадан бөлінуді алып тастаймыз, мұнан соң тікбұрыштың жиегінде маркерлер пайда болады.

    Маркерлекр – бұрыштар бойынша айналуға, ортасы бойынша еңкеюге арналған құрал. Енді бұрыштар бойынша маркерлерді пайдалана отырып, орбитаны шамамен 450- ге бұрамыз, бұл оны шындыққа жанастырады.   

Фильм жасау кезінде анимацияның алуан турін көрсету үшін біз элиптикалық орбитамен планетаның айналасындағы спутник қозғалысын және планетаның өз өсінде айналуын ұйымдастырдық. Осы лабораториялық жұмысты орындауды шағын ролик жасауды толық түсіну мен бұл   Flash программасы мен онда жұмыс істеуге қызығушы кез келген адам қайталау мүмкіндігі үшін қадамдап түгел сипаттадық.

2.6. Дыбыс біріктіру мүмкіндігі

Flash, фильмде дыбысты қолданудың бірнеше әдісін ұсына алады. Сіз үзіліссіз, фильм сюжетіне және пайдаланушы әрекетіне тәуелсіз жүргізілетін дыбыстар біріктіре аласыз. Дыбыспен жұмыс істеудің альтернативті нұсқасы – анимация мен дыбысты синхронизациялауға болады. Бұдан басқа тағы да Flash, дыбыс едәуір интерактивті болуы үшін оны кнопкамен тағайындауға мүмкіндік береді. Дыбыспен жұмыс істеудің тағы бір нұсқасы – дыбыстық біріктіруді ActionScript сценариі арқылы басқару.

Flash’те дыбысты біріктірудің екі үлгісі қарастырылған: оқиғалық-басқармалы (event sound) және ағымдық (stream sound). Оқиғалық-басқармалы дыбысты жүргізу үшін, лайықталған берілгендер толығымен жүктелуі қажет; осыдан соң дыбыстың жүргізілуі, айқын өзі біткенше жалғастырыла береді. Ағымдық етілген дыбыстың жүргізілуі үшін, жүктелген берілгендер фильмнің алғашқы бірнеше кадрына жеткілікті болса болғаны.

Flash, дыбыспен жұмыс істеудің ыңғайлылығы жоңары болуы үшін авторларға келесі мүмкіндіктерді жеткізеді:

· бөлек дыбыстар кітапханасын құру, бұл бір кітапханадағы дыбыстарды бірнеше фильмде қолдануыңызға мүмкіндік береді;

· дыбыстық берілгендерді қысу параметрлерімен жұмыс; мұндағы мақсат: дыбыстың сапасын және экспортталатын фильмнің өлшемін таңдау; мұнда автор жеке бір дыбысты қысқан сияқты фильмдегі барлық дыбыстарды қысу  параметрін таңдай алады.

Сондай-ақ, сіздер, дыбысты модификациялау үшін әр түрлі қосымша эффекттерді қолдана аласыздар . Ол үшін Пуск => Все программы  => Стандартные => Развлечения => Звукозапись командасын берсек, дыбыс жазуға арналған арнайы программа терезесі ашыл
  

12-сурет.Дыбыс жазуға арналған программа терезесі.
Дыбысты Flash’те импорттау. Flash’те дыбысты импорттау үшін, сол дыбысқа арнайы жеке қабат (слой) құру керек, және сол қабатта бос кілттік қадр болуы тиіс. Бос кілттік кадрды құру үшін, дыбыс басталатын кадрдың үстіне тышқанды апарып оң түймесін басып, көрінген контекстті мәзір тізімінен “Вставить пустой ключевой кадр” командасын таңдаймыз.

Керекті дыбысты импорттау үшін мәзірлер қатарынан Файл => Импортировать командасын береміз. Ашылған терезеде дыбыстарды сақтаған буманы ашып, қажетті дыбыстық файлды таңдаймыз.
[image: image13.png]Do ¥ QAP@

Sveam e Troa
D G Doty
Hegowe |31 Dhersoot
a3 i
1027 Amoneo-Armasen  <Jforcte Mkt aboney
[ v i 2wom
Patowdicron || AT ] ur tokpak.

=] ertney Spears - Waking away ] vorona
] Faceza Malinga - Tala Al Bacu 4] 4, EHCENOB - Xadws

2 =) Janbir 2] A Encenos - fetcren

Mo porgren | K82 =) Bacat - Kan kaiane (remix)
=] Karga orig. ] yaBEKCTAH
A kust 2] Yrerray - Kown Tonkeel
g; ks
ks
Mot E
Kormorep
Q’g Vian aine: |05 N.Baizakova - Kinbatim v [Comem

Cerepoe | Tonoaime: [Bos ompm ) B o=





13-сурет.Импорттау терезесі

Дыбыстарды импорттап болған соң, мәзірлер қатарынан Окно => Библиотека командасын берсек, кітапхана терезесі ашылады.
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14-сурет.Кітапхана терезесі
Осы жерден қажет дыбысты тышқанмен таңдап, тышқанның сол түймесі басылған күйде оны жұмыс терезесіне апарып, түймені жібереміз. Сонда, дыбысымыз бос кілттік кадрға жазылады. Дыбыстың ұзындығына байланысты, кадрды F5 функционалдық пернесі арқылы ұзартамыз
    2.7. Macromedia Flash – фильм жасау

   Енді біз    Layer 1 қабаттың атауын Планетаға немесе өзіңіз қалаған атқа өзгертеміз, бұл планета бейнелейтін қабат болады.

     Сосын екінші қабатты жасаймызда, оны орбита деп атаймыз сонан соң Планета қабатында орбитаны белгілеп алып Ctrl+X басамыз, орбитаны кесіп қабатты бөлеміз.

     Орбита және мәзір пунктімен  Edit → Paste in Place немесе   Ctrl +Shift + V  командасын таңдап, орбита бір атаулы қабатта кескен орынға қоямыз.

     Macromedia Flash – тегі фильм олардың уақыт шкаласында орналасу көлемі бойынша орындала тын кадрлар тізбегі. Әзірге анимация жасалмағандықтан уақыт шкаласындағы әрбір қабатта бір ғана кадр бар. Кадрлар уақыт шкаласында жіңішке сұр жолақтармен белгіленген. Ойнамалы басты пайдаланып кадрдан кадрға көшуге болады, ол уақыт шкаласында қызыл  түспен белгіленген және бүкіл қабатты бірден қиып өтеді.

        Macromedia Flash – те анимацияның екі түрі болады. Кадрлдық (Frame by Frame ) және  есептік ( Tween animation).

        Егер кадрлық анимацияда біз әрбір кадрды жеке жасасақ, есептікте бастапқы және  соңғы кадрдың арасындакғы аралық кадрларды басқарады. Есептік анимацияның екі түрі болады: қозғалыс анимациясы motion tweening және форм анимациясы shape tweening .

     Тағы бір қабат жасап, оны спутник деп атаймыз да, сосын кітапхана панелін ашамыз, тышқанның сол жақ түймешігін спутник символына басып, оны осы қабатта ауыстырамыз, бірақ оның ортасы орбитаның ұшымен сәйкес келу керек. Бұны өте нақты жасау үшін  планете қабатын өшіру керек. 

   Орындалған әрекеттерден соң бізде спутник қабаттында шешуші кадр  пайда болады. Енді спутникті орбитада қозғалтумен айналысамыз. Спутниктібөліп аламыз, мәзір пунктінен Window → Panels→Frame таңдаймыз немесе Ctrl +F ті басамыз, да сонан соң Frameжзинағына өтеміз.Бұл жинақта спутник үшін келесі қасиеттерді айқындауға болады:

· Label – белгі

· Tweening – аралық бейнеғлер жасау

    Non  туралы – анимацияның болмауы.Mation – туралы Анимациянцың бұл тәсілінде Flash сіз берген шешуші кадр арасындағы аралық кадрларды автоматты турде жасайды. Бұл сіз обьектінің суретін алып, сосын келесі кадрда өзгерту жасап,  Flash –тен осы шешуші екі кадрдың арасында жатқан кадрларды есептеуіңізді сұрайтыныңызды білдіреді. Ол бұүл жұмысты орындайлы, сіз бұдан жүзбелі анимация аласыз.

   Shape  туралы – сізге шаршы дөңгелекке немесе көжек суреті қасқыр сулуеті қалқып өтуі қажет делік. 

· Scale(on off) -           масштаптау

· Easing           -           жылдамдату 

· Rotate                       айналымдар санына ену өрісі мен айналу

Orint to path (on off) –троектория бойынша қозғалу

Synchronize  (on off)- синхромдау

Snap (on off) –таң

Спутник үшін белгілі жазу қажет емес, Mation Tweening- ті таңдаймыз, тездету мен айналымды қалдырамыз да, ары қарай масштаптау, траектория бойымен қозғалу, синхромдаумен таңу өрістерінде белгі қалдырамыз.  Ctrl + S не File →  өзгерістерін сақтацймыз.

    Спутник үшін жасалған өзгерістерден соң, барлық қабаттарда 66- кадрды бөлеміз және Ғ6 – ны басып, оны шешуші етеміз. Егер қабаттарға енді қарасақ, онда орбита және планета қабаттарындағы кадрлардың сұр түспен, ал Спутникте 1-ден 66 – ға дейін созылған сілтегіші барн көкшіл туспен толғанын көреміз. Бұл спутник үшін дәл қазір қойылған қасиеттердің көмегімен оның қозғалысын басқарғанын білдіреді. Біз қазір қабаттағы 66- кадрға өтуге тиістіміз.

       Спутник және спутникті бөліп алып, оны орбитаның келесі ұшына орналастыру. Ең қызығы анимацияны  жасалуын    тексеру. Бұл үшін мәзір пунктімен Window → Toolbars  → Coneroller  - ді таңдаймыз және бақылаушы пайда болған соң қосу пернесін басамыз(ол оң жақта тілше  түрде орналасады), оны тоқтату үшін тоқта түймешігін басу керек (ол толтырылған шаршы түрінде белгіленген ). 

     Ары қарай барамыз, Спутник қабатын бөліп аламыз, уақыттың шкаладағы  2 түймешіктің немесе қабатты бағыттаушы Insert → Motion Cuicle  мәзірі пунктінің көмегімен қосамыз. Ол аталған жағдайда олардың астында орналасқан қабатқак байланысты Спутник деп аталады, ал олардың астындағы қарапайым қабат біршама оңға жылжытылады. Енді бұл қабатқа оны Планета қабатынан орбита қабатына көшіргендей етіп, орбитаны көшіреміз. Осы операциядан соң бағыттаушы қабатты 1- ден 66- ға дейінгі барплық кадрлар толтырылады. Бұл төмендегідей болуы керек:

      Спутниктің орбитада қозғалысын жасау үшін Планетаға енген спутник жоғалатындай, ал пайда болғанда оның орбитада орналасу орны бойынша ұлғайатындай ету керек. Бірақ плеерде анимациялауда қозғалыстар циклі үздіксіз қайталанатындықтан спутник планетада шамалы уақыт кешігуі үшін циклданр арасында аялдама жасау қажет . Монымен уақыттың шкалаға әрбір кадрдың басында тағы 4 кадрдан қосамыз. Бұл үшін бастық уақыт шкаласының басында орын ауыстырып, Ғ5 түймешігін 4 рет басу керек. Олай болса, айнашамы бас 5 белгісіне орын ауыстырды. Енді спутник қабатын бөліп, айнашамы басты 5 белгісіне ауыстырамызда Ғ6 – ны басамыз, осылайша жаңакадрдың мазмұнын сол жақта таяу тұрған мказмұнының көшірмесін алады. Соңғы кадырға  да осылай етеміз. Енді соңғы кадрға қайта ораламыз және Info терезесінде 0? 0 спутник көлемін құоямыз, соңғы кадрғада осыны жасаймыз. 

     Спутник орбитаның ортасына жуықтау көлемі бойынша біртіндеп ұлғайып, ал сосын қайтадан азаюы үшін тағыда  бірнеше шешуші кадр жасауға болады. Мұны біз былайша жасаймыз: айнашамы басты спутник орбита мен планета ортасында болатын белгіге орнаттық және спутник өз көлемін 34- тен  60- қа өзгертектін шешуші кадр қойдық. Сосын әрбір 4 кадрдан соң алдымен, спутник көлемін 60-тан 55-ке дейін азайта отырып оңға, сосын 55-тен 50-ге дейін , және 34- ке жеткенге дейін қайта шешуші кадрлар қойды. 

      Фори анимациясы (Shape tweening ). Бұл қадамда біз планетаның өз өсі айналасында айналу таңдалуы үшін фори анимациясымен айналысамыз. Бұл жағдайда планета өздігінен жылжымайды, тек оның формасы,  түсі, орналасуы немесе көлемі өзгереді. Кездейсоқ зиян келтіріп алмас үшін Планета қабатынан басқа қабаттардың барлығын блоктауджан бастаймыз. Планетаны бөліп Frame (Ctrl + F) терезесін ашамыз және бір атаулы жинақта фори анимациясының түрін қоямыз:

       Ары қарай уақыт шкаласында, Планета қабатында барлық кадрлардың бойында жасыл түсті тілше пайда болады. Жасыл түс бұл   жағдайда  дәл  фори  анимациясының   қолданылғанын  білдіреді.  Енді ойнамалы   басты   бірінші шешуші кадрға орнатамыз  және аспаптар  панелімен  құйма  таңдаймыз,   төменгі    қасиеттерде        Transform Fill    таңдаймыз. Тышқанның сол түймешігін басқанда планетада өзгерістер пайда болады. 

Фильм пареметрлерін күйге келтіру. Лабораториялық жұмыстарды біз  Macromedia Flash бағдарламасының ашылған мүмкіндіктерін көрсететін кез  келген  Web -  свайттың бас беті ашылар алдындағы қойылым ретінде қолдануға болатын қарапайым анимациялық фильм жасаймыз. Біз МХ версиясындағы фильмді жасайтын боламыз. Анимациялық  фильм жасау кезінде біз элиптикалық орбита бойынша планетаның айналасында спутник қозғалысын және планетаның өһз осі айналасында айналуын ұйымдастырдық. Бұл лабораториялық жұмысты орындау шағын ролик жасауды біз  Flash программасына және онымен жұмыс істеулерге қызығырақ  болуы үшін мұқият сиппаттауға шешім қабылдадық.  
       Flash   программасын меңгеру мен өзіңіздің анимациялық фильміңізді жасауда сіздерге табыс тілейміз.

      Лабораториялық жұмысты орындау үшін біздің сайтымыз бекн МХ версиялы Macromedia Flash   бағдарламасын  бірмезгілді жүктеуге кеңес  береміз.  Сайттта сіз роликті қалай жасау керектігін оқисыз ,  ал Flash МХ  қосыла отырып бірте – бірте кино жасай аласыз.

Фильм параметрлерін күйге келтіру. Macromedia Flash   - ті жіберіп, File → New  мәзірінде Спутник деген атау берілетін Flash  ролик болатын жаңа  файл жасаймыз, бұл біздің ролигіміздің мақсатына сәйкес келетін болады.  Ролик жасауды бастаудың алдында фильмнің қажетті күйлерін қалпына келтіру керек:

1. Frame Rate – бұл кадрдың 25 fps – ке дейінгі жиілігі күрделі графика үшін кадрлардың жиілігін  8- fps –ке дейінгі азайту керек.
2. Dimensions – мұнда кадрлардың ені мен биіктігі пикселдерде көрсетіледі, бұл мән 550? 400-ге тең браузердегі фильм кадрларының көлемінде тура осындай болады.   
3.  Match – мұнда да  Printer   және  Conters  түймешіктерінің көмегімен кадрдың көлемін көрсетуге болады. Осы кадрдағы көрініс арқылы кадр көлемін білу үшін Contens  түймешігін басқару керек. Егер кадр көлемін баспа параметрлеріне сәйкес ету керек болса Printer түймешігін басу керек, көптеген компьютенрлер үшін тиімді мән 12 fps болады. Егер фильм қарапайым болып, ол өте жылдам компьютерде қарастырылса, онда бұл мәнді ұлғайтуға болады.

4. Background color  –  Кадрлар  фонының  түсі,  жорта  айтқанда  бұл ақ.

5. Ruler units – сахнадағы кадр көлемін бейнелейтін сызғыштың өлшем бірліктері.Тізімнен бізге қажет бірліктер алынады. Жорыта айтқанда сызғыштар ажыратылған, ал оларда View → Rulers  мәзір командасының көмегімен қосуға болады. Қойылған параметрлерді қолдану үшін Fawn  Default түймешігін басу керек.

2.8. Flash фильмдерін пайдалану тәсілдері

Жоғарыда айтылғандай Flash’тің негізгі түпкі мақсаты – графика және анимациямен қаныққан интерактивті Web-беттер құру. Алайда Flash – айтарлықтай дербес технология. Сондықтан да оны жасаушылар, сондай-ақ нәтижені пайдаланудың басқа тағы екі тәсілін қарастырған. Біріншісі Flash-фильмді (Web-браузерден) тәуелсіз карау, екіншісі Flash-фильмді басқа форматқа конверсиялау (конвертирование) мүмкіндігі.

Фильмдерді Flash редакторынан тәуелсіз қарау.Flash көмегімен фильмдерді жасау және редактрлеу кезінде автор FLA форматты файлдармен жұмыс істейді. Бұл Flash редакторының ішкі (жеке) форматы, және ол осы инструментке ғана “түсінікті”. Web-браузер арқылы көру үшін тағайындалған фильмдер SWF форматына экспортталуы қажет. Жоғарыда көрсетілгендей, нақ осы формат браузерлердің соңғы (Internet Explorer, Netscape және Opera) версияларына және арнайы қосатын Flash-плеерге арналған. Міне, осы әлгі Flash-плеер, айтарлықтай дербес қосымша ретінде Flash редакторының құрамына кіреді, және Flash редакторының қосылуынсыз-ақ оның көмегімен SWF-файлдар активтендіріле алады. Сонда автор арқылы жүзеге асқан Flash-филмдердегі функционалды және интерактивті мүмкіндіктер сақталады. Flash редакторында жасалған, SWF форматына экспортталған  және Flash-плеердің көмегімен ашылған Flash-қосымшасы көрсетілген.
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          15-сурет.Электрондық оқулық көмегімен SWF файлдарды көру

Flash-фильмдерді “автономды” түрде көрудің екінші тәсілі - Әмбебап ойнатқыш  (Windows Media Player) көмегімен көру. Ол үшін Flash-фильм AVI форматына экспортталған болуы керек. Бірақ, мұндай жағдайда фильмнің (дәлірек айтқанда, фильмі бар файлдың) көлемі он есе, ал кейде жүз есеге үлкейеді
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16-сурет.Электрондық құралдағы сабақтар мәзірі.
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17-сурет.Электрондық құралдағы жаттығулар тізімі.
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18-сурет.Электрондық  құралдарғы жаттығулар.
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19-сурет.Электрондық оқулыққа жан бітіру.

Қорытынды


Қорытындылай келе, бұл дипломдық жұмыста  қарастырған тақырып бойынша, яғни тәрбиелік мағынасы зор электрондық оқулық жасауда Flash программасының  мүмкіндіктері мақсатымызға толық жету үшін өте маңызды рөл атқарады. Және оның оқулықтар жасаудағы басты артықшылықтарының бірі – бұл программада шексіз көп кадрлар мен қабаттарды қолдануға болады. Macrpmedia Flash технологиясын сондай-ақ қашықтықтан оқыту (дистанционное обучение) әдісіне арналған оқулықтар жасауда да пайдалануға болады. Мысалы, физикалық, математикалық және химиялық құбылыстарды Macrpmedia Flash’те демонстрациялап, ол оқулықтарды қашықтықтан оқыту әдісіне қолдануға болады. Бұл дипломдық жұмыста осы мәселеге де қатысты интерактивті оқулықтар жасалынды. Демек осы сияқты Macrpmedia Flash-оқулықтар жасап, ол оқулықтар арқылы белгілі бір тақырыпта кең көлемді сабақ өткізуге болады. Мұндай фоқулықтар оқушылардың немесе студенттердің сабақты тез әрі оңай түсінуіне ықпал етеді.
Macromedia FLASH-те анимация, мультфилмдер,роликтер рекламалар жасау өте қызықты.Әрине бұл програмама өте қиын программа.Бірақ оқып үйрену керек. Сондықтан Дипломдық жұмысымда Macromedia FLASH – тің электрондық оқулық ретінде жазуды ұйғардым.

Macromedia Flash технологиясын оқыту мүмкіндіктерін алу себебім де осыда және осы Macromedia Flash  технологиясын информатика мамандықтарына оқыту үшін арнайы сағат бөлінсе деген ұсынысым бар. 


Ойымызды толықтырар болсақ, Macrpmedia Flash технологиясының атқаратын қызметтері біздер үшін өте үлкен маңызға ие десек те болады.
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